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IBM Retail – MicroStrategy Solution Demonstration G uide 
 
 
 
 

About this Guide  

 
This guide details how to demonstrate the IBM® Retail – MicroStrategy Solution.  

 

Who should read this guide 
This guide is intended for a sales or technical professional who is demonstrating the IBM Retail -
MicroStrategy Solution.  The user should: 

·  Have basic knowledge of data management infrastructure and processes 

·  Be familiar with the needs of retail companies 

·  Be familiar with the product components of the Retail - MicroStrategy Solution 

Contact information 
For additional information, or to schedule a demonstration, contact: 

Jeffrey Douglas 
Manager, BI Solutions Development 
408-463-2301 
jgdoug@us.ibm.com 

MicroStrategy-RBIS Integration  
 
Two-thirds of Fortune’s Global 500 retailers rely on MicroStrategy for sophisticated analysis 
against the largest data sets.  MicroStrategy is a leader in the retail sector due to its unique 
ROLAP architecture, which allows for unparalleled user and data scalability, as well as access to 
the transactional level of detail.  MicroStrategy supports all five styles of Business Intelligence 
through a single unified platform and metadata, including Scorecards & Dashboards, Reporting, 
OLAP, Advanced Analysis, and Alerts & Proactive Notification.  
  
Now the robust analytical capabilities of the MicroStrategy BI Platform™ can be leveraged 
against IBM’s Retail Business Intelligence Solution (RBIS) to create a powerful retail-specific 
BI/DW combination.  The MicroStrategy RBIS demo includes reports in areas of market basket 
analysis, graphical enterprise reporting documents, allocation & assortment reporting, and 
inventory analysis.  The demo also features embedded analytics within everyday MicroStrategy 
reports through a unique integration with IBM Intelligent Miner.  
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How to connect to demo server  

 
To demonstrate Retail Solution reports with MicroStrategy, complete the following steps: 

Note: Web browsers other than Internet Explorer are not yet supported. 

1. On your client machine, point Internet Explorer to the URL 
http://docs.dfw.ibm.com/rbismstr/  

 

 

 

Figure 1:  Landing Page 

 
Use the box on the right of the screen 'Access demonstration'.  Select “Login to the live demo” 
from the list. (This should point to a URL like 
http://rbismstr.dfw.ibm.com/MicroStrategy/servlet/m strWeb  ) 

 
 
2. You will be directed to a page that has the demo project ‘MicroStrategy-RBIS Integration’. 
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3. Click on ‘MicroStrategy-RBIS Integration’.  In the Login dialog, verify or enter the following 
values: 

User name : bisdemo 
Password : demo4you 

 

       

 
After logging in, you will be redirected to a page that should look like Figure 2.  
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Figure 2:  List of available reports 

 
A list of retail reports for a fictitious retailer, ValueTrend Superstore, will appear.  You can use one 
of the ‘View’ buttons to view the reports as icons or as a list.   
Trend Analysis - Sales, Out of stock analysis and Target Product Affinity, Basket Rules and 
Potential Revenue are the reports for this demo.  
 

There is no need to go in to the Base Reports folder. The demo will go through 
reports in the Shared Reports folder level only. 

 

Business Scenarios  

This section contains scenarios that demonstrate ways in which a business user can access and 
analyze data using the Retail–MicroStrategy Solution. 
 

Scenario 1: Back to School Trend Analysis 

 
This scenario takes place in the first week of August (the back to school season).  The Junior 
Buyer, Cindy, is reviewing her department and category sales performance (by dollars) for last 
week for both ‘% to Plan’ and ‘% to Last Year’. 
 
Cindy logs into the MicroStrategy – RBIS Integration solution. She selects the “PDF” link  under 
the report “Trend Analysis – Sales ”.  

 

Note 



Page 7 of 27 

 
In the PDF document that opens, she selects the “Girls Junior ” Department from the bookmarks 
on the left.  (The document will open in a new browser window) 
 

 

 
 
Cindy notices that, overall, DENIM looks very strong with +80% to plan and she decides to drill 
down further to find out what products within DENIM are indicating a trend.  She clicks on the 
Subdepartment “Denim”  to drill-down. 

 
Cindy’s next screen might look like this: 
 

 
 

This is a feature of MicroStrategy that turns page-fields into PDF bookmarks when exported. 
Also note the highly formatted nature of this enterprise document, with images, grid and graph 
data, all with pixel-perfect placement. 

This is another feature of MicroStrategy reports that actually allows the user to drill to another 
highly formatted document, which means, drilling capability can be enabled for users without 
them ever having to leave the enterprise report layout. 
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Cindy’s original plan called for ‘JEANS GIRL’ to be planned higher to last year but in this case it is 
trending even higher with +114% to her plan. 
 
All of the inventory delivery requirements were optimized to the original plan. The fact that JEANS 
GIRL is trending higher means that Cindy might run out of inventory. She needs to react quickly. 
However, she first must analyze which particular styles and cuts are driving the overall trend.  
Cindy then drills down to the individual styles in JEANS GIRL (by clicking on the “Jeans Girl” 
Product Class to drill-down again ) and she finds ‘LOW RISE STONE WASH’ jeans as the 
leader with sales being 140% higher than in the original plan. 
 

 
 
Cindy now decides to do further analysis of units on hand and on order. She selects the “Click 
here for further analysis ” link. 
 

 
 

 

This feature of MicroStrategy allows to seamlessly transport users from the enterprise report 
output in PDF to the underlying report in MicroStrategy Web where they can do further OLAP 
analysis. 
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Cindy has discovered that, while most fashion styles are not selling well, the Low Rise Stone 
Wash style is trending extremely well. She decides to check the Inventory numbers for the “Low 
Rise Stone Wash style so that she can make business decisions based on those numbers. 
 
She right-clicks on the “LOW RISE STONE WASH”  Product Subclass to access the drill sub-
menu and select “Inventory Template”.   
 

 
 
This takes Cindy to the Inventory report for ‘LOW RISE STONE WASH’. (This page might take a 
few seconds to load). 
 

 
 
 

 
Close this browser window  before going to the next scenario. 
 

Scenario 2: Out of Stock in the Health and Beauty D epartment  

 
In this scenario, a buyer of Health and Beauty performs a series of progressive drill downs. The 
buyer starts by looking at the ‘Out Of Stock  Analysis ’ report and he selects the page for 
‘HEALTH and BEAUTY’.   He notices that sales are below plan in HAIR CARE but the inventory 
is in good shape with respect to the plan and last year.  
                            
Go to “Shared Reports” at the top of the Web page (this is page you see after logging in to the 
solution) and click on the “Out of Stock Analysis ” report name or icon to execute.   

This highlights the powerful features in MicroStrategy called Drill Maps  and Drill to Template  
which allows us to build custom drill paths for reports, and more specifically to drill from one 
report directly to another (in this cases, from a sales report to an inventory report) without 
having to start at the top again. 
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The buyer wants to send this report with improved formatting to his colleagues. He then changes 
“Department” grouping  to “HEALTH AND BEAUTY”.  (If you don’t see this grouping, go to drop-
down menu View �  Grouping). 
 
 

 
 
He highlights the “Product Out of Stock Analysis” titl e and centers the text, italicizes it and 
makes the background yellow.   
 

 
 

Instead of exporting the document to PDF, this will execute it in HTML in “WYSIWYG” mode 
which is much more interactive than PDF documents. Some of interactive features are 
demonstrated in the actions listed below. 
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He then right-clicks on the “Sales Amount” metric title and sorts the column  in descending order. 
   

 
 
He right-clicks on the “Sales Amount” metric title and selects “Insert Metric” ��� �  “Percent to 
Total” ��� �  “Over Rows ”.    
 

 
 
 
He clicks on the “View” drop-down menu and then selects “Dataset Objects”.  He drags and 
drops the “Cost” metric onto the grid  and places it in front of the “KPIs” column.  
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He then drags and drops grid to re-center it to produce a report like this. 
 
 

 
 
The buyer of Health and Beauty continues to analyze sales performance. By looking at the Out of 
Stock Analysis report, (below the grid), he notices that sales figures for a couple of product lines 
in the HAIR CARE sub-department are very poor. 
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The buyer clicks on the “Department” hyperlink  (below the grid) to go into the underlying 
report and analyze the HEALTH AND BEAUTY department data. 
 
 

 
 
The numbers for HAIR CARE Subdepartment are troubling.  He then decides to drill down further 
into HAIR CARE Subdepartment data. 
 

The Outline Mode (Drill-in-Place) functionality is shown here by clicking on the “plus signs” 
next to “HAIR CARE”, “SHAMPOO”.  
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The buyer notices that SHAMPOO is struggling in sales. He also notices that his shampoo 
inventory on hand is running below plan and last year. 
 

 
 
The buyer clicks on “DRY HAIR” to drill down  (Click on the Outline Mode button to expand the 
data).  One product, “SHAMPOO HERBAL FREESIA" shows sales and inventory very low 
compared to plan and last year. 
 

 
 
The buyer then looks into the ordering system. He sees that orders are placed for this product but 
the actual deliveries are running behind. The buyer calls the supplier. The supplier admits that 
she is late in delivering this shampoo and offers an incentive to make up for the lost sales due to  
that product being Out of Stock. 
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Scenario 3:  Target Class Affinity 

 
Click on the “Shared Reports” link at the top of the page and run the “Target Product Affinity ” 
report.  On the Prompt screen, leave the selected item, “SHAMPOO BIOSILK VI350 12875 CA”, 
in the “Selected” window and click the “Run Report ” button in the lower left-hand corner. 
 

 
 
 
What the Health and Beauty manager notices is that when shoppers buy SHAMPOO BIOSILK 
VI350, they also buy products used for daily hygiene, such as Toothpastes, Soaps, Conditioner, 
etc.  Based on this information the manager changes the layout of her ad.  Instead of featuring 
just one product, she will display a combination of products, promoting a stock up visit for daily 
cleansing needs. 
 
The above scenario demonstrates product affinity analysis when the target product is known. 
The analysis that can be performed when the target product is unknown (i.e. when the analyst is 
looking at any two products that sell together) is demonstrated via the two scenarios in the 
following section. 
 

Advanced Analytics for Market Basket Analysis 

 
One of the important tasks in the analysis of market baskets is finding associated products that 
customers buy together. This is called product affinity analysis. The information about associated 
products is used, for example, in the design of cross-sell campaigns. A marketing or sales 
manager might know some of the associated product pairs already based on previous experience 
or applying common sense. The solution includes a couple of reports that can be used to check 
how often certain pairs of products are sold together.  Finding all frequent pairs including the non-
obvious ones isn't easy, however. Most pairs of products are rarely sold together. 
 
The advanced analytics report for market basket analysis addresses this problem of finding all 
relevant product associations. For example, the user can select product departments and then 
the small application will find the product associations. Internally it uses a data mining algorithm 
from DB2 Intelligent Miner that does an exhaustive search over all combinations. Doing this 
manually would be far to time consuming and tedious for a human user. The mining analysis is 
hidden behind a reporting interface that makes the analysis easy to perform for reporting users.  
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Run the ‘Basket Analysis’  report from Shared Reports. 
Product affinity results are presented as a simple report that shows pairs of associated products. 
 
 

 
 
 
The first line in this sample output tells the user that customers who buy the product 
‘BLEACHING BLONDOR’ also buy 'KOLESTON ACTIVADOR 30V’.  
The Confidence measure  says "If a customer buys BLEACHING BLONDOR, in 75% of these 
cases, the customer also buys KOLESTON ACTIVADOR 30V". Note that this value is rather high 
and this indicates this product combination would be interesting to use for cross-selling.  
Lift  is another measure computed for each association rule. Without going into details how this 
indicator is computed, a high value indicates a product combination that is more important than 
others. 
 
Now run the ‘Potential Revenue’ report from Shared Reports folder (scroll to the bottom of this 
report). 
 
Actual revenue comes from the actual transactions containing the implied product. The potential 
revenue is calculated assuming every customer buying ‘BLEACHING BLONDOR’ would also buy 
the implied product 'KOLESTON ACTIVADOR 30V’.  This describes the financial effect that a 
cross-sell campaign could potentially have. 
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How to work with MicroStrategy 
This section describes how a user builds a report from scratch when he cannot find any of the 
custom reports from the previous list that meet his needs. 

How to create a custom report 

 
1. Click on the “Create Report” link at the top of the page. 
 

 
 
2. Click on the “Blank Report” link. 

 

 
 

 
3. Click on the “Attributes” link and put “Subdepartment” in the rows of the grid and 

“Department” in the Page-by window. 
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4. Click the up-folder button to go out of attributes and click on the “Metrics” link. 
 

 
 

5. Add the “Sales Amount” and “Profit” metrics to the columns of the grid. 
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6. Click on the “Edit Report Filter” button on the top of the page. 
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7. Click the up-folder button until you can click on the “Attributes” button again, and drag 
and drop the “Year” attribute into the Report Filter window. 

 

 
 

8. Click the “Select” radio button and select “2004”.  Click the checkbox button to 
confirm your selection. 

 

 

checkbox 
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9. Click the “Run Report” button at the top of the page to see the results. 

 

 
 
The results might take a while to come back at this step. 

 
 

10. Change the autostyle to “Corporate”. 
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11. Move the “Department” page field into the rows of the report in front of 
“Subdepartment”.  Hit the “Undo” button. 

 

 
 

12. Right-click on the “Profit” metric and select “Insert Metric”, “New…”. 
 

 
 

13. Name the metric “Profit Margin” and define as [Profit]/[Sales Amount].  Click “OK”. 
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14. On the formatting toolbar, select “Profit Margin” from the drop-down list and then click 
on the “Percent” button on the toolbar to format the metric. 

 

 
 
 

15. Increase the decimal specificity of the metric 2 places and make the fill “Yellow”. 
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16. Right-click on “Profit Margin” and select “Remove from Grid”.   
 

 
 
 

17. Click on the graph button and change graph to “3D Risers”.  Click on the grid and 
graph button.  Switch back to grid. 
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18. Go to the “View” drop-down menu and select “Object Browser”.  Drag “Profit Margin” 
back onto the report. 

 

 
 

19. Go to the “Data” drop-down menu and select “Filter on Selections”.  Check the boxes 
next to “BLAZER SCHOOL”, “PANTS SCHOOL”, “SHIRTS SCHOOL” and click the 
“OK” button. 
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20. Right-click on “PANTS SCHOOL” and drill to Class. 
 

 
 
 

21. Show totals (Averages) 
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22. Print and export 
 

 
 

 


